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1ception, Binnacle Training has been
oted to providing Secondary Schools and
with the support and teaching resources
to ‘Make Life Easier for Teachers’.

ays been driven by one ethos, to make our programs easy to
deliver, ALLOWING TEACHERS TO TEACH.

Our experience in the education field is what gives us the edge. We understand
the daily challenges that teachers face and are single-minded about ensuring
you have the space, resources, support and skills (through first-class
professional development) to thrive.

We are proud to be partnering with over 250 Secondary Schools, working with
800+ teachers, and offering over 15 nationally recognised courses
custom-built for schools, across five Program Areas: Sport and Recreation,
Fitness, Business, Tourism and First Aid.

Our growing team occupies three office locations to best uphold our reputation
for outstanding service and providing ‘great teacher experiences’.

OUR MISSION OUR VISION

We are leaders in Vocational To unlock the true potential of
Education in Schools, enabling Australian Secondary Schools and
teachers with quality programs and provide quality Vocational Education
support; equipping students with to every student.

skills to navigate a successful future.
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Welcome to our 2024 Subject Selection Course Guide.

For the past 17 years, our ethos of “Making Life Easier for Teachers’ has been the
cornerstone for everything we do at Binnacle.

Guided by this ethos, we used 2022 and the theme of
‘possibilities’ to catapult us forward in bold ways. This
included:

> Facilitating our Semester 1 Binnacle Workshops
virtually - leveraging our state of the art ‘Elevate’ (virtual
streaming) platform - enabling all of our teachers to
“connect and share” with their fellow Deliverers and the
Binnacle Team across two days.

> Expanding interactive online learning within our own
online platform (Binnacle Lounge) for all of our courses
to support our teachers and students.

> Implementing a Statewide Strategy for Binnacle-
organised workplace visits - opening the door for
various face-to-face touchpoints and allowing teachers
to connect, share and remain industry current.

> Achieving a 275% increase in the number of schools
delivering a Tourism program and recording record
student numbers undertaking a Business and Tourism
program offering.

> Continuing to invest in technology, resource
development and Binnacle-employed assessors as
aligned to our inclusive delivery strategy.

> Celebrating our 10th year where we've gathered our
teachers to a central professional development event
(VET in Schools Conference).

2023 is an exciting and important year for Binnacle. We
vow to make an impact that matters - with our people
and partnerships at the heart of everything we do. We are
proud to be partnering with over 250 secondary schools,
working with 800+ teachers; and offering five industry-
relevant certificate programs purpose-built - by teachers
for teachers.

|l Page4

FOR OUR TEACHERS

My personal commitment to you with the help of all staff
at Binnacle, we will make your life easier - providing you
with the space, support and skills (through first-class
professional development) to thrive.

FOR OUR STUDENTS

| encourage you to speak to your teachers, VET
coordinator and/or guidance counsellor, friends and family
about your future. Your Binnacle qualification - aside from
giving you real-world learning - may also contribute to
your employability, and for some your ATAR as well. So
completing a VET course is not just a great way to get a
head start on your career, but it can also help you get into
your dream university course sooner (if that is the path
you have in mind). We are here to support you in your next
steps, to find your passion, and give you the best chance
of success.

For further information you can also visit our website
www.binnacletraining.com.au, email programs@
binnacletraining.com.au, or speak to our friendly Support
Team on 1300 303 715.

Aaron Bulow
Chief Executive Officer
Binnacle Training RTO 31319

< VISIT OUR WEBSITE [} )
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TIMELINE OF EVENTS

17 YEARS OF
BlINNACILE

2006

Established as the
Australian Sport and

Fitness College (ASFC)
2008

School Partnership
Program launched

+ North Queensland
expansion

Changed name to
Binnacle Training College

Digital assessment
introduced +

50 Partner Schools ._m

Binnacle Business
is launched +

Binnacle Lounge
(Online LMS) is

200 Partner Schools
250 Partner Schools

Binnacle Tourism is
launched + Virtual ViSC

m_. <7OO+ TeaCherS)
Hybrid ViSC is

launched
Semester 1 Virtual
Workshops

m_. (split across 2-Days)

Launch of Statewide
Strategy for Industry
Workplace Visits
(Teacher HR)
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WHY STUDY

WITH

BINNACIE

IRAININGE

Binnacle Training are leaders in VET in Schools, enabling teachers with quality
programs and support, equipping students with skills to navigate a successful future.
We are united in our commitment to ‘raising the bar’ with the following highlights
showcasing our impressive record to date:

MORE THAN

17 YEARS

Of experience
delivering VET in
Schools as a company

15,000

ACTIVE STUDENTS

Approximately each year

91%
COMPLETION RATE

Of Student courses

MORE THAN 500
ACTIVE CLASSES

Across Queensland
and the ACT

OVER 250

BINNACLE
PARTNER

Secondary Schools

OVER 15

NATIONALLY
RECOGNISED COURSES

Offered each year

3 OFFICE

LOCATIONS

Brisbane, Ipswich
and Townsville

E

PROGRAM AREAS

Sport and Recreation,
Fitness, Business,
Tourism and First Aid

22 COLLECTIVE

YEARS DELIVERING
BINNACLE PROGRAMS

Our Program Managers
have firsthand experience
delivering our programs in
Secondary Schools

OVER 800
TEACHERS SERVING

Secondary Schools
across Queensland
and the ACT
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REAL SKILLS FOR

R

CUSTOM-BUILT
STUDENT & TEACHER

FRIENDLY

Online Learning
Management System
(LMS)

ALL

TEACHING &
ASSESSMENT

RESOURCES PROVIDED
Within the Binnacle
Lounge

CUSTOM-BUILT
STUDENT & TEACHER

FRIENDLY

BINNACLE LOUNGE

I Pages

FIRST-CLASS

PROFESSIONAL

DEVELOPMENT
FOR TEACHERS

Workshops, Industry
Workplace Visits, Webinars,
Masterclasses and ViSC
Conference

FLEXIBLE & STUDENT

FRIENDLY
PROGRAMS

1, 2 and 3-Year
Pathways

PRACTICAL AND
PROJECT BASED

LEARNING

Assisting students to
acquire key enterprise skills
for the future world of work

— AENCAREERS

DEDICATED

TEACHER
SUPPORT TEAM

Direct access to your
dedicated Program
Management & Administration
Support Team

CERTIFICATE PROGRAMS
PURPOSE BUILT
FOR SCHOOLS

For Secondary Schools
(Years 10-12) by Industry and
Education Experts

LIVE & REAL-TIME
PROGRESS REPORTING

Student Feedback and
Progress Reporting - take the
stress out of teacher marking

Binnacle Training Course Guide 2024



DEDICATED TEACHER SUPPORT

SUPPORTING

TEACHERS

SNeE 2006

Our Program Management and Administration Support Team are our secret weapon!

Our Program Managers are trained teachers with over
22 collective years of teaching experience delivering our
Binnacle Training programs in schools. Their primary
purpose is to provide the best possible support to our
Partner Schools to allow our teachers (i.e. our Program
Deliverers) to do what they do best — TEACH!

Our Administration Support Team are trusted with
creating great experiences for Binnacle teachers by ‘going
the extra mile’ with program and support services.

We pride ourselves on tackling the administrative burden
and delighting you with real-time response and service
support.

In line with our growth, we continue to strengthen our
School Support Team by having a dedicated Program
Manager and Administration Support Officer to support
you on your journey. Don’t just take our word for it!

< HEAR FROM OUR TEACHERS R >

l Page9
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VET IN - OO

VET in Schools is about gaining practical work-related skills to equip you for the

world of work while you are at school.

The number of schools and students involved in VET programs
has increased in recent years and most schools now offer some
VET options to Senior Secondary Students.

According to the latest data from the National Centre for
Vocational Education Research (NCVER), the number of
school students undertaking vocational education and training
(VET) as part of their senior secondary certificate of education
in Queensland increased by 14.4 percent in the 2021 year.
Significantly, this is 10.2 percentage points higher than the
increase nationally.

NCVER 2022, VET in Schools 2021, NCVER, Adelaide.

I Page 10

All VET training embedded in Queensland Curriculum and
Assessment Authority (QCAA) subjects and school-based
apprenticeships and traineeships count towards a VET
qualification as well as the QCE; in effect, allowing students
to mix general and vocational education, and make a start on
training for a career before they leave school.

As well as readying students for the workforce, VET programs

can lead to further study, either in the VET sector (where students
can gain credit for their VET certificate) or University.

Gollege

Binnacle Training Course Guide 2024




ATAR AND

QCERCHR

YIS

Achievement of a VET Certificate Ill or above, in combination with results in General
Subjects, can contribute to the calculation of a student’s Australian Tertiary Admission

Rank (ATAR).

The ATAR is used nationally and indicates a student’s position

relative to other ATAR-eligible students. Queensland ATARs are

based on a student’s:

> Best five General Subject results, or

> Best results in four General Subjects, plus one Applied
Subject, or

> Best results in four General Subjects, plus one VET
qualification at Certificate Ill or above

Each level of VET qualification includes a single scaled result
that can be used to calculate a student’s ATAR. Regardless of
the course of study, duration, or content of the VET qualification,
the scaled result in any given year is the same. A Certificate Ill in
Business and a Certificate Il in Fitness, for example, will result in
the same scaled outcome.

Completed VET courses can be utilised for tertiary admission
in one of two ways:

> As part of the ATAR; and/or

> As a stand-alone basis of admission

A completed VET qualification at the Certificate Il level and
higher may be considered by institutions as a basis for tertiary
entrance.

WHAT ARE QCE CREDITS?

VET courses also contribute towards a student’s Queensland
Certificate of Education (QCE) which is Queensland’s Senior
Secondary Schooling Qualification. To receive a QCE,
Queensland students must achieve the set amount of learning
which is 20 credits, which can include VET qualifications. Please

see our Program-specific sections for more information regarding
maximum QCE credits derived from VET qualifications offered by
Binnacle Training to Queensland Senior Secondary Students.

I Page 11



UNIQUE STUDENT

D EINIEI

ERXUS])

All students undertaking VET must have a Unique Student Identifier (USI).

WHAT IS A USI?

A USI is your individual education number for life. It also gives

you an online record of your VET training undertaken in Australia.

If you’re at university, TAFE or doing other nationally recognised

training, you need a USI. Without one, you can’t receive

Commonwealth Financial Assistance or your qualification or

Statement of Attainment.

CREATE A USI

A USlI is your lifelong
education number —
you only need to create
it once.

|l Page 12

KEEP A RECORD OF
YOUR NUMBER

If you have undertaken
any registered training
since 2015, you may
already have a USI.

At enrolment, each student will be required to create
(or simply supply if previously created) a USI.

Binnacle Training is required to verify the USI’s we collect from

students in accordance with the Student Identifiers Act 2014.

This ensures the correct USI is being used for the student.

ENROL WITH A
PROVIDER

When you enrol to
study, your education or
training provider will ask
for your USI.

ACCESS YOUR VET
TRANSCRIPT

Access your nationally
recognised VET record
online, set permission
for your training
organisation to view
your VET transcript.

Binnacle Training Course Guide 2024
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LANGUAGE, LITERACY AND
NUWERAGY SIKILLS

All courses incorporate competency units, which focus on employability skKills.

A Language, Literacy and Numeracy (LLN) Screening process is A suite of LLN Screening activities are provided by Binnacle
undertaken at the time of initial enrolment (or earlier) to ensure Training to help identify the key LLN skills (including ACSF level
students have the capacity to effectively engage with the content ranges 1-3) relevant to each Binnacle Program.

and to identify support measures as required.

THE PURPOSE OF THIS LLN SCREENING IS TO IDENTIFY:

> Students that may not (yet) be suited to officially enrol in a Please visit the ‘Student Information’ Quicklink within our
Binnacle Course Support Centre for a snapshot of the reading, writing, numeracy

and verbal communication skills that would be expected in order

to satisfy competency requirements for each Binnacle Program.

> Students that may require individualised LLN support (i.e.
development of an Individual Learning Plan)

[ ¢\ Binnacle
+ For schools v For students v Why Binnacle ~ Events v Contact us

Home Contact us RTO Documents

Support Centre

Binnacle RTO Files Quicklinks

Q 4 RTO Files

Search
+ Third Party Agresment
4 Resource Requirements

4 Independent Contractor

Favourites
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THIRD PARTY
A@REENUENTT (UrRey)

BINNACLE TRAINING AND THE SCHOOL

Binnacle Training (as the RTO) engages individual high schools under a
Third Party Agreement.

As principal RTO in this Third Party Agreement, Binnacle Training THE SCHOOL’S RESPONSIBILITIES CAN BE
remains fully responsible for ALL services provided on its behalf DIVIDED INTO 3 KEY AREAS:

by the Partner School (as Third Party), including the outcomes

of all training and assessment. This highlights the importance of 1. The provision of adequate physical resources,
Binnacle monitoring and evaluating the performance of the Third 2. The provision of adequate human resources
Party Agreement we have in place with the school to ensure an (qualified Trainers and Assessors); and

effective, compliant working arrangement. 3. The facilitation of training and assessment services.

BINNACLE TRAINING RESPONSIBILITIES SCHOOL RESPONSIBILITIES (AS THE THIRD PARTY)

Enrolling students into the VET course Provision of adequate physical resources (facilities,

equipment and access to clients), verified by Binnacle

Provision of all requisite training and assessment
resources, including online learning

Provision of adequate human resources
(qualified Trainers and Assessors)

Training and assessment outcomes . .
9 > Including at least one backup deliverer who can meet

the HR requirement

Issuing certificates
Facilitation of training and assessment services

— on behalf of, and in the name of, Binnacle Training as
Ensuring the VET course is on its scope of the RTO. This includes:

registration at all times . ) L
> Provision of support services for students requiring

LLN assistance

Systematic monitoring of each Third Party Agreement > Accurate teacher marking (assessment evidence; valid,
sufficient, authentic, current)

As the RTO, Binnacle Training is fully responsible for all
services provided on its behalf by the Partner School (as
Third Party)

VIEW THIRD PARTY AGREEMENT Q )

| Page 14 Binnacle Training Course Guide 2024
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BINNACLE
LOURIE=

LEARNING MANAGEMENT SYSTEM

In 2023, we are proud to be celebrating 10 years of the Binnacle Lounge - our very own
Learning Management System (LMS) that has been custom-built for Schools, Teachers
and Students. With innovation at the forefront, we have enabled the quality facilitation of
our programs with a technology solution without peer in VET in Schools.

THE BINNACLE LOUNGE PROVIDES:

» Real-time status reporting on student
outcomes specific to your program

» Certificate on completion (a simple
download)

» All course content in one central location

> Interactive online learning including
program and tutorial videos

» Zero paperwork
» Unlimited access - anytime, anywhere

( WATCH OUR LOUNGE SHOWCASE I} ) > Online Teacher Profile forl streamlined
management of HR requirements

Delivered mindfully, we are continually evolving and investing in the Binnacle Lounge (and our
digital learning resources) to create great experiences for our students and teachers alike.

l Page 15
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BINNACLE - ~0O-1L

The Binnacle Profile allows our Program Deliverers to systematically gather the evidence
required to satisfy their requirements as a Binnacle Program Deliverer and to record
their ongoing Industry and VET-related Professional Development. Our Partner School
Performance team monitors each Program Deliverer’s profile throughout the year and,
together with our Program Managers, assists Program Deliverers in attaining and

maintaining a “Current” Profile.

REQUIREMENTS OF A TRAINER AND ASSESSOR (I.E. TEACHER)

All Program Deliverers are required to submit evidence to satisfy

their course-specific Human Resource Program Requirements.

This includes initial evidence including their Work History, current

Certificate IV in Training and Assessment, relevant Industry
Qualifications and completion of a Vocational Competence

Update (VCU), gathered in Parts 1-3 of the Profile. Program
Deliverers are also required to submit ongoing evidence of
Industry and VET Professional Development, each semester, in
Part 4 of the profile.

PART 1: REQUIRED TO CREATE A CLASS

PART 2: REQUIRED TO ENROL STUDENTS

> Induction

> Account details

> Training programs

> Evidence of recent work history

Part 1 of the profile must be completed before a Program
Deliverer can create a class. Program Deliverers will be required
to:

> Watch the Induction Videos and complete
acknowledgements

> Provide personal details, study details and contact details

> Select the training programs they will be delivering for the
school year

> Provide an industry relevant work history entry (within the last
3 years, or ongoing)

> Evidence of qualification (TAE & Industry Qualification)

Part 2 of the profile must be completed before a Program
Deliverer can enrol students in their class.

Program Deliverers will be required to upload their course
specific Industry and VET Qualifications for verification and
approval by our Partner School Performance Team.

This will include a current Certificate IV in Training and
Assessment and relevant VET Certificate or Degree
Qualifications for the course being delivered.

PART 4: INDUSTRY & VET PROFESSIONAL DEVELOPMENT

PART 3: TRAINER EVIDENCE

TPA Due: End of Week 5, Term 1
VCU Due: End of Term 1

> Current Third Party Agreement (TPA)
> Evidence of vocational competence (VCU)

Part 3 of the profile collects trainer evidence through completion
of relevant VCU and the Schools TPA (competed annually by the
school VET Manager, establishing the Third Party Agreement
between Binnacle Training and the School).

Program Deliverers are required to complete a VCU for all Units
of Competency in the course being delivered which they do not
formally hold. The VCU involves the collection of evidence that
verifies the Program Deliverer has the skills and knowledge to
deliver the Unit of Competency.

Due: Semester 1 - 30 June
Due: Semester 2 - 30 November

> Evidence of industry workplace visit
> Evidence of industry professional development
> Evidence of VET professional development

Part 4 of the profile requires Program Deliverers to complete a
minimum of one 3-Hour Professional Development Activity for
each of the three criteria per Semester:

> Industry Workplace Visit
> Industry Professional Development
> VET Professional Development

Binnacle Training provides professional development
opportunities throughout the year, at no additional cost, to assist
Program Deliverers in maintaining their currency. This includes:

> Binnacle-organised Workplace Visits in all major Queensland
Regions

> Binnacle Virtual Workshops in Term 2 - Satisfying VET and
Industry PD for Semester 1

> Binnacle’s VET in Schools Conference (ViSC) in Term 4 -
Satisfying VET and Industry PD for Semester 2

> Additional Virtual options for Professional Development
where required

| Page 16
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EXAMPLE OF A
SACHIERS PROIFIL

Profile status

Welcome to your profile! Your profile is linked to your ability to enrol
students into a course. Completion of your profile will finalise
students’ official enrolment in the courses you will teach,

Part 1: Required to create a class

Benjamin Luinys
Binnacle Training SHS

Induction )

Watch the induction videos and complete B

acknowledgements Profile status
Account details

) < A Eoofile home
Enter or update your personal and professional :

details

Part 1: Required to create a

Training programs ] class
Update which courses you will deliver this year Current

Induction © .

Evidence of recent work history °
Current

Account details o -
Part 2: Required to enrol students 4
Evidence of qualification (TAE & Industry (/] Training programs 9 ;
Qualification) Current

Evidence of recent (-]

Part 3: Trainer Evidence
TPA Due: 24 February 2023
VCU Due: 1 April 2023

work history rrent

Part 2: Required to enrol

students
Current Third Party Agreement : Q .
TPA @ o
Ll Evidence of
qualification (TAE & [/]
Industry rrent

Evidence of vocational competence (VCU) - 0 RQuslification)

Part 3: Trainer Evidence
TPA Due: 24 February 2023
VICU Due: 1 April 2023

Part 4: Industry & VET Professional Development
Due: Semester 1 - 30 June 2023
Due: Semester 2 - 30 Movember 2023

Current Third Party (]
Agreement
Evidence of industry workplace visit g _.o, ;gg;q ]
Evid f
Evidence of industry professional development + e [}
Add now vecational

competence (VCU)

Evidence of VET professional development

Part 4: Industry & VET
Professional Development

Due: Semester 1 - 30 June 2023
Due: Semester 2 - 30 November
2023

Evidence of industry [}
workplace visit

Evidence of industry +
professional

ey Add now

Evidence of VET +
professional

Add now
development e
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PER PROGRAM

VET AND INDUSTRY
CURRENCY
RE@QUIRENMENTS

In order to remain Industry “current” in the Program Area(s) being delivered, Teachers are
required to participate in both Industry and VET professional development each semester.

A three hour minimum PD (per activity) is required in order to maintain a “Current” Profile
status each semester.

EACH PROGRAM DELIVERER MUST MAINTAIN CURRENCY IN INDUSTRY AND VET WHICH INCLUDES:

Recent Work History > Industry relevant work history (minimum one position within the previous 3 years)

> A minimum of one industry relevant workplace visit per semester

Industry Currenc
it/ L > A minimum of one industry relevant professional development per semester

VET Currency > A minimum of one VET-specific professional development per semester

Participation in Binnacle’s Semester 1 Workshops and Binnacle’s VET in Schools Conference (ViISC) in Semester 2 will
suffice the deliverer’s Industry and VET professional development for the year (these events do not suffice the industry

relevant workplace visits however).

Note: Industry Currency requirements have been reduced for First Aid and Short Course only program deliverers

to one per year.

( OUR UPCOMING EVENTS R )
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REQUIREMENTS OF A
NRAINERIANDINSSESSOR

As the nominated Trainer and Assessor, each Binnacle has developed a customised Vocational
Binnacle Program Deliverer (i.e. Teacher) must hold Competence Update (or VCU) which streamlines
a current Certificate IV in Training and Assessment the process for our teachers to demonstrate their
(TAE); the relevant industry qualification (e.g. vocational competence.

Certificate Ill or higher such as an Industry-related

degree); and demonstrate vocational competence

specific to EACH unit within the qualification(s) they

are set to deliver.

TAE REQUIREMENT INDUSTRY QUALIFICATION AND VCU REQUIREMENT:

Have vocational competencies (skills and knowledge) at
Hold the Certificate IV in Training and least to the level being delivered and assessed. Must:

Assessment (TAE40116 or its successor TAE40122) > Hold each unit of competency (including electives); OR

> Demonstrate ‘equivalence’ to each unit of competency
- by obtaining Third Party Verification from a
nominated workplace supervisor (per unit)

Or hold the TAE40110 Certificate IV in Training and

Assessment, plus the 2 core units from the TAE40116:

. Address adult language, literacy and numeracy (LLN) Vocational Competence Update — demonstration of

skills (TAELLN411 or equivalent): vocational competence specific to each unit comprising

the qualification(s) being delivered

> Design and develop assessment tools (TAEASS502 or
- Free, 100% online, provided by Binnacle

equivalent)
- Industry Qualification required prior to VCU
> Used to support your ‘demonstration of equivalence’
> Must be at the same, or higher qualification level
Or hold a diploma or higher qualification in ‘adult’ > Some qualifications e.g. Certificate Il in Fitness
education require the Assessor to hold a higher qualification (i.e.

Certificate IV in Fitness)

Industry Qualification must be uploaded to your Binnacle

TAE must be uploaded to your Binnacle Profile
Profile prior to commencement of the VCU

l Page 19



SPORT, FITNESS & RECREATION COURSES

VET AND INDUSTRY
QUALIFICATION
RE@QUIRENMENTS

Each Program Deliverer must have the following evidence requirements in place
prior to the commencement of delivery:

SIS30115

S1S30321 SIS20115 S1520321

CERTIFICATE Ill IN
SPORT AND RECREATION
(STANDALONE AND DUAL
QUALIFICATION)

CERTIFICATE Ill IN FITNESS
(STANDALONE AND DUAL
QUALIFICATION)

CERTIFICATE Il CERTIFICATE
IN SPORT AND 11 IN SPORT
RECREATION COACHING

Hold the Certificate IV in Training and Assessment (TAE40122, TAE40116 or TAE40110%)
Certificate qualification:
IVin * If using the TAE40110 qualification, two core units must also be held:

Training and 1. TAEASS502 Design and develop assessment tools (or equivalent); and
Assessment 2. TAELLN411 Address adult language, literacy and numeracy (LLN) skills (or equivalent).

Or Hold a diploma or higher qualification in ‘adult’ education.

Hold a Certificate
IV in Fitness with a

collective p.eno.d (?f two Hold a Sport, Fitness and Recreation (SFR)-related VET
years working in fitness

Industry ; . qualification (Certificate Ill or higher) and/or Degree in a Sport,
instruction

Qualificati . Fitness and Recreation (SFR) industry area.
uatttication (or be a registered/ : fon ( ) industry

accredited practising
exercise professional with
a degree and experience).

Demonstrate vocational competence in each unit of competency.

Vocational Binnacle’s free, non-accredited Vocational Competence Update (VCU) is used to demonstrate
Competence | current vocational competence specific to each unit of competency within the qualification(s) being
delivered. Deliverers will need to either hold the unit of competency, OR demonstrate equivalence
(demonstrate vocational competence) using verifiable evidence for each unit.
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FIRST AID & CPR COURSES

VET AND INDUSTRY
QUALIFICATION
RE@QUIRENMENTS

Each Program Deliverer must have the following evidence requirements in place
prior to the commencement of delivery:

TAE STATEMENT OF SERVICE

HLTAIDO11 HLTAID009

PROVIDE FIRST AID PROVIDE CARDIOPULMONARY RESUSCITATION

Hold the Certificate IV in Training and Assessment (TAE40122, TAE40116 or TAE40110%)
qualification:

Certificate IV * If using the TAE40110 qualification, two core units must also be held:
in Training and . .
A R 1. TAEASS502 Design and develop assessment tools (or equivalent); and
ssessmen 2. TAELLN411 Address adult language, literacy and numeracy (LLN) skills (or equivalent).
Or Hold a diploma or higher qualification in ‘adult’ education.
Industry Hold a current Provide First Aid Certificate (within 3 years) and CPR Certificate
Qualification (within 12 months). These must remain current for each new class being delivered.

Complete a ‘Statement of Service - First Aid Officer’ (every two years).
Verified by their Head of Department or line manager and is used to demonstrate First Aid
related recent work history using verifiable evidence.

Statement of
Service
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BUSINESS & TOURISM COURSES

VET AND INDUSTRY
QUALIFICATION
RE@QUIRENMENTS

Each Program Deliverer must have the following evidence requirements in place
prior to the commencement of delivery:

INDUSTRY QUALIFICATION

BSB30120
CERTIFICATE Il
IN BUSINESS

SIT20122
CERTIFICATE
Il IN TOURISM

BSB20120
CERTIFICATE Il
IN WORKPLACE

BSB30120 CERTIFICATE Il IN BUSINESS +

SIT20122 CERTIFICATE Il IN TOURISM (DUAL SHORE

COURSES

QUALIFICATION)

SKILLS

Hold the Certificate IV in Training and Assessment (TAE40122, TAE40116 or TAE40110%)

(STANDALONE)

(STANDALONE)

qualification:
?e_lf_ﬁf!‘??te v g * If using the TAE40110 qualification, two core units must also be held:
in Training an ) .
Assessmgnt 1. TAEASS502 Design and develop assessment tools (or equivalent); and
2. TAELLN411 Address adult language, literacy and numeracy (LLN) skills (or equivalent).
Or Hold a diploma or higher qualification in ‘adult’ education.
- Ho!q a I'3usiness.*.relevant VET Program Program
qualification (Certificate Ill or higher) Deliverer must Deliverer
and/or Degree; and hold a Business must hold
. . - . . Must hold a Business-
- Hold a ‘Tourism, Hospitality or relevant VET a ‘Tourism, P
s P e o related VET qualification
Events’ relevant VET qualification qualification Hospitality o )
Industry o ) e ; (Certificate Il or higher)
e (Certificate Il or higher) and/or Degree. (Certificate Il or Events )
Qualification high d/ | VET and/or Degree in a
* The ‘Tourism, Hospitality or Events’ or higher) an relevant V Bloincastraaied
relevant qualification - if Certificate Il or Degree in qualification industry area.
or higher - may also be considered a Business (Certificate Il or
as satisfying a Business relevant industry area. higher)
qualification. and/or Degree.

Demonstrate vocational competence in each unit of competency.

Binnacle’s free, non-accredited Vocational Competence Update (VCU) is used to demonstrate current
vocational competence specific to each unit of competency within the qualification(s) being delivered.
Deliverers will need to either hold the unit of competency, OR demonstrate equivalence (demonstrate
vocational competence) using verifiable evidence for each unit.

Vocational
Competence
Tourism Deliverers Only - must have undertaken a Tourism-related industry placement (minimum one full
day) prior to commencing their VCU specific to the Tourism-specific units.
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VOCATIONAL

GCOWPETENGE URDEE

Binnacle’s method for retaining evidence of Vocational Competence for “Trainers and

Assessors’ (i.e. Teachers)

THE STANDARDS FOR RTOS SPECIFY THAT THE RTO’S TRAINING AND ASSESSMENT IS DELIVERED

ONLY BY PERSONS WHO HAVE:

1. Vocational competencies at least to the level being delivered and assessed.

2. Current industry skills directly relevant to the training and assessment being provided.

3. Current knowledge and skills in vocational training and learning that informs their training and assessment.

A GUIDE TO COMPLIANCE:

Evidence relating to Trainers’ and Assessors’ industry skills can
take many forms. If a ‘Trainer and Assessor’ (i.e. Teacher) holds
the qualification they are delivering and has recent extensive
industry experience, this may be sufficient to demonstrate they
hold both current industry skills and vocational competencies.
In the circumstance that the trainer and assessor does not

hold the qualification, the RTO needs to analyse the skills and
knowledge they deliver and compare this to their industry skills
and knowledge. They must consider all Units of Competency
(including electives) in this analysis to ensure that trainers

and assessors are meeting the requirements specified in the
training package.

DURATION

This VCU program is estimated to take approximately two hours
and must be completed and verified by your Third-Party Verifier
by the 1st of April (within the first year of the program if required).

THIRD-PARTY VERIFICATION REQUIRED

VOCATIONAL COMPETENCE UPDATE (VCU)

All intended Trainer and Assessors (i.e. Teachers) are required to
complete a (free) non-accredited Vocational Competence Update
(VCU). These custom VCU'’s allow our ‘Trainer and Assessors’ to
demonstrate current knowledge and skills specific to each unit of
competency within the qualifications being delivered. Deliverers
will need to either hold the unit of competency OR demonstrate
equivalence (in skills and knowledge) using verifiable evidence
(third-party verification from a nominated supervisor). Upon
successful completion, you will gain a (non-accredited) Certificate
of Completion which recognises your vocational competence as
a Binnacle Program Deliverer.

EVIDENCE REQUIRED

You will be required to upload evidence in your Profile and
complete the: Evidence, Unit List and Third Party tabs prior to the
assessor unlocking the units tabs.

You will be required to nominate a Third-Party person to verify your knowledge and skills related to each unit of competency within
this qualification (if you do not hold the unit of competency). The Third-Party person must have an understanding of the industry
expectations in relation to the knowledge and skills being performed. We encourage you to discuss the requirements with your
nominated Third-Party prior to proceeding. Your VCU can not be successfully completed until an electronic email verification is
received from the Third-Party nominee and approved by Binnacle Training.

Assessments

Lounge Home

L My Profile
Nol Current

& Enrelments

= My Leaming

o My Review

Certlll Fitness VCU

& My Certificates

= View Submissions

Course: 2023 VCU: SFR Essentlals

I Course Content
1 Class Cerifficates Class: Completed 2023 VCU: SFR Essentials

0 Teacher Surveys

| vcu

Course: 2023 VCU: SIS30321 Certificate lll in Fitness

Class: Completed 2023 VCU: 51530321 Certificate lll in Fitness
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TEACHER
PROFESSIONAL

DEVSLORPRIERTT

At Binnacle Training we value developing relationships with our teachers through face-to-face and virtual
professional development opportunities.

VET IN SCHOOLS \/*
CONEERENCE 1ISC

Binnacle Training’s annual VET in Schools Conference (ViSC) is a one-day Professional
Development event for Binnacle Deliverers, typically held in Term 4, Week 8 each year.

This conference is now delivered in a hybrid format - and includes our traditional live face-to-face element along with a current live
virtual experience using Binnacle’s ‘Elevate’ virtual streaming platform for Binnacle Deliverers across Australia, giving Teachers more
access than ever before.

Our teachers will leave ViSC with actionable content from leading industry professionals addressing all Binnacle Program Areas
(Fitness, Sport and Recreation, Business, Tourism and First Aid) as well as staying up-to-date on key Binnacle Updates across each of
our courses.

( VISC 2022 HIGHLIGHTS Q )
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https://vimeo.com/778709871
https://vimeo.com/657653137

SEMESTER 1 Binnacle
WORKSHORPS o

Curated specifically for Binnacle Training teachers, our workshops are
delivered virtually using Binnacle’s ‘Elevate’ streaming platform in Semester 1

each year.

Our Semester 1 Workshops are specifically tailored for our These workshops help our teachers deepen their knowledge and
Binnacle Program Deliverers with leading industry professionals assist with their program delivery whilst providing a wonderful
addressing all Binnacle Program areas (Fitness, Sport and networking opportunity with other deliverers from their region and

Recreation, Business, Workplace Skills, Tourism and First Aid) as across the state.
well as information on key Binnacle Updates across each of our
courses.

( 2023 WORKSHOP HIGHLIGHTS R >
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INDUSTRY
WORIKPLACE WISITS

We are proud to support our teachers by investing in real-world industry
workplace visit experiences for our teachers.

These Industry Workplace Visits aim to broaden our Program by providing at least one Binnacle-organised Industry Workplace
Deliverers’ understanding of industry-specific standards and Visit per year, for each program area (Fitness, Sport and
practices (delivering a breadth of industry exposure, beyond the Recreation, Business and Tourism). Binnacle-organised Industry
classroom). We understand that fulfilling the Industry Workplace Workplace Visits will be provided in all Major Queensland regions,
Visit PD requirements can be challenging for teachers to meet, including - Gold Coast, Met South/Central, Met North, Met East,
within their busy schedules. We are committed to continuing to Met West/Toowoomba, Sunshine Coast, Rockhampton, Mackay,

help our Binnacle Program Deliverers to meet these requirements  Townsville and Cairns.

DREAMWORLD WORKPLACE VISIT Q )
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DISCOVERY 0):\/<

Discovery Days afford students the opportunity to undertake a real-word
immersion (i.e. Discovery) in an authentic learning environment along with their
class peers and teachers, thus ‘Connecting Industry with the Classroom’.

This immersion occurs via observing and/or participating in the Discovery Days are a wonderful supplement to actual work
common work activities of any given workplace. This includes experience — particularly for students who may not be able
seeing interactions among staff and customers, a tour of the to secure work experience that is specifically aligned to their
work facilities and observing the application of organisational Certificate Program. These experiences also provide each of
procedures. In doing so, students are best able to link what they our Program Deliverers (i.e. Teachers) with an ideal Industry

are learning as part of the Binnacle Certificate Program to that of Workplace Visit which forms part of a teacher’s HR requirements.

an actual workplace.

< STUDENT TESTIMONIAL Q > < TEACHER TESTIMONIAL Q >
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“@SCHOOL RESOURCE
REQUIREMENTS

Aspart of the Third Party Agreement with Binnacle Training, it is essential that
e “the Physical Resource Requirements of your school’s facilities are met prior to
s s,

L

e “pre 1.delivery..Please visit the ‘Resource Requirements’-quicklink within our
"'_'\ }’ = Su;ﬁ?)rt Centre to view the course-specific resources required to enable a smooth
A

i‘: :ﬁraiﬁitiorl inte.2024.

( VISIT SUPPORT CENTRE Q )
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SPORT, FITNESS AND RECREATION PROGRAMS

SCHOOL PHYSICAL
RESOURCE
RE@QUIRENMENTS

2024 SPORT, FITNESS AND RECREATION PROGRAMS

SHORT
CERTIFICATE PROGRAMS
COURSES
SCHOOL PHYSICAL RESOURCE SIS30113 51530321
Certificate ll | oc ificate I
REQUIREMENTS ; in Sport and in Fi
0 Introduction SIS_2_0115 51520321 Recration in Fitness
to Sport + Certificate Il o . ) ) (with optional
) h Certificate Il in (with optional
Introduction to in Sport and Sport Coachin SIS20115
Fitness Recreation P 9 C%Ir?i?ig,;:esll Certificate Il
h in Sport and
i Sport_and Rec?eation)
Recreation)
Sport and Recreation facilities and equipment — located at the school.
A sport-specific training or competition environment. N4 N4 N4 N4 N4
Facilities where a sport-specific range of officiating and
coaching activities can be conducted. ‘/ ‘/ ‘/ ‘/ ‘/
Equipment and resources appropriate for one or more
specific sports. ‘/ ‘/ ‘/ ‘/ ‘/
Organisational safety, emergency response and first aid
procedures for the specific sport. ‘/ ‘/ ‘/ ‘/ ‘/
Access to athletes and novice/beginner participants. N4 N4 N4 v N4
Key health and safety equipment and/or aids. N4 N4 v v v
First aid kit v v v v v
Personal computers with office software and internet
access. v v v v v
Repair equipment and maintenance resources (e.g. ball
pumps, cleaning equipment). N/A ‘/ ‘/ ‘/ ‘/
Maintenance storage facilities (.g. storeroom). N/A v N4 v v
Sport Specialty (NRL, Netball, Rugby Union, Other) schools:
Must also have access to events, games or competitions N/A N4 N4 v v
where students will assist as officials (e.g. Gala Days).
At.:c.ess to .somal r.ned.la tools and applications (e.g. blogs, N/A N/A N/A ‘/ N/A
wikis, social media sites).
Access to participant groups (other than peers) for the
purpose of gaining experience delivering sessions to real
participants (e.g. primary school or junior secondary school N/A N4 N4 N4 N4
students). The venue/facility for these SFR programs must
include a range of SFR activities and equipment.
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SPORT, FITNESS AND RECREATION PROGRAMS

SCHOOL PHYSICAL
RESOURCE
SelUIREMIENTS (GO0

SCHOOL PHYSICAL RESOURCE REQUIREMENTS

SIS30321 CERTIFICATE Il IN FITNESS ONLY

A Fitness (Gym) Facility — located on the school premises.

Fitness assessment equipment — located on the school premises.
If you require items from the list below, click on the following link to source
many of these items at discount prices. VISIT BINNACLE SHOP

A variety of exercise modes (including with and without equipment).

Tape measures (such as a stadiometer to measure height)

A range of exercise equipment including cardiovascular, resistance and
flexibility.

Sit and reach tools

A variety of exercise areas including resistance, cardio, flexibility, circuit and
outdoor.

Stationary bicycle, treadmill or rowing ergometer

Adequate space to cater for groups/multiple trainers.

Heart rate monitors

Key health and safety equipment and/or aids.

Blood pressure monitor

A range of programs and services.

Body weight scales

Afirst aid kit.

Stop watches

Access to Adult (age 18+ years) and Older Adult (age 55+ years) Clients - Term 6 & 7*
The School (Third-Party) must have access to the following adult and older adult clients — with all 9 sessions, instructed by each student, undertaken on school
premises (or an external fitness facility as arranged by the School) - for practical assessment purposes and assessed by the Binnacle Program Deliverer.

6 x 1-ON-1 GYM-BASED SESSIONS: Each student is required to instruct six gym-based sessions (minimum session duration of 30 minutes) for the following individual
clients in Term 6 & 7*:

v 1 xfemale adult (age 18+ years) — minimum of 2 sessions

v 1 xmale adult (age 18+ years) — minimum of 2 sessions

v 1 xolder adult (age 55+ years) — minimum of 2 sessions

3 x GROUP EXERCISE SESSIONS: Each student is required to instruct three group exercise sessions (minimum session duration of 45 minutes) for the following client
groups (with a minimum of 6 participants in each group) in Term 6 & 7*:
v A group that is predominantly comprised of female adults — minimum of 1 session
(i.e. a minimum of 6 participants with at least 4 x female adults aged 18 years or over)
v A group that is predominantly comprised of male adults — minimum of 1 session
(i.e. @ minimum of 6 participants with at least 4 x male adults aged 18 years or over)
v A group that is predominantly comprised of older adults — minimum of 1 session
(i.e. a minimum of 6 participants with at least 4 x older adults aged 55 years or over)
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FIRST AID & CPR

SCHOOL PHYSICAL
RESOURCE
RE@QUIRENMENTS

2024 SPORT, FITNESS AND RECREATION PROGRAMS

SHORT

COURSES CERTIFICATE PROGRAMS

SIS30115
SCHOOL PHYSICAL RESOURCE cortonon | (S50
. ertificate IlI
REQUIREMENTS Introduction 51520115 - ';:;‘;:tfo':‘d in Fitness
to Sport + Certificate Il Certificate I in ith ontional (with optional
introductionto | in Sportand | > Ncee LY (W§|S;81'$ga $1520115
Fitness Recreation P 9 - Certificate Il
Certificate Il .
. in Sport and
in Sport and .
) Recreation)
Recreation)
First Aid training equipment
If the First Aid competency will be delivered via the Binnacle
Program - refer to mandatory items in table below. e ‘/ ‘/ ‘/ ‘/

FIRST AID & CPR

SCHOOL PHYSICAL RESOURCE REQUIREMENTS

First Aid training equipment — located at the school:

MANDATORY EQUIPMENT | MINIMUM (*Suggested) QTY MANDATORY EQUIPMENT MINIMUM (*Suggested) QTY

Adult CPR Manikin 1 manikin per 4 students* Asthma Spacers 1 trainer per 4 students*

Infant CPR Manikin 1 manikin per 4 students* Asthma Spacer Mouthpieces 1 per student

CPR Face shield or Clean Face 1 per student for each manikin Triangular Bandage 1 per student (new)*

Alcohol Wipes Tub Roller Bandage 1 per student (new)*
AED Trainer 1 trainer per 4 students* Spare Clean Bandages/Slings Assortment

Gloves (S, M, L) Box of each size Workplace (?rsntg::iigé First Aid Kit 1 per class*

EpiPen Trainers 1 trainer per 4 students* Pillows and Blankets Assortment

Asthma Puffers (Placebo)

1 trainer per 4 students*

Simulated Hazards

As per workplace

If you require any of the First Aid training equipment above, click on the following link to source these items at discount prices. VISIT BINNACLE SHOP
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BUSINESS AND TOURISM

SCHOOL PHYSICAL
RESOURCE
SCUIRENMENTS

2024 BUSINESS AND TOURISM PROGRAMS
SHORT COURSES

CERTIFICATE PROGRAMS

SCHOOL PHYSICAL S
RESOURCE T A

Inclusivity and Communication in the Workplace | BSB20120 SIT20122 BSB30120 Certificate Il
REQUIREMENTS + Technology in the Workplace Certificate Il Certificate Il in Certificate Ill in Business
+ Financial Literacy Workplace Skills | Tourism Business + SIT20122
Certificate Il in
Tourism

Business-related facilities and resources — located at the school.

A simulated ergonomic office environment

and workplace equipment including a \/ \/ \/ \/ \/

desk, chair, printer and paper.

Personal computers with office
software (Microsoft Office — documents,

spreadsheets, presentations), internet V4 v N4 v v
access and browser, PDF reader and email
application.
Access to school WHS and risk
N/A v v v v

management procedures.

Key health and safety equipment and/
or aids. A ‘/ ‘/ ‘/ ‘/

Access to ‘real customer groups’ within
the school community (to advertise to and
deliver products and services to within the
school environment).

N/A v v 4 v

Access to facilities suitable for hosting
events e.g. function room or school hall.
> A public activity or event on which
students can work. e ‘/ ‘/ ‘/ ‘/
> Interaction with staff involved in
staging a public activity or event.

Presentation equipment to present
information to a group.

N/A v v v v

A simulated Tourism-related industry environment - located at the school.

A simulated ergonomic office environment \/

(Tourism-related) and workplace “Inclusivity and Communication in the N/A N4 N/A N4
equipment including front desk. Workplace only

Access to customers and staff* from

a diverse range of social and cultural ‘/

groups, with whom the student will B S N/A \/ N/A \/
interact. *Individuals who participate in “Inclusivity and Communication in the

simulated activities, set up for the purpose Workplace only

of assessment.

Facilitating a Student Industry Discovery Day - at a Tourism-related workplace.

Students participate in @ minimum of one
industry discovery day (Tourism-related), N/A N/A v N/A v
preferable in Semester 1
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& REGREATION p
RROGRANS

1,2 AND 3-YEAR PATHWAYS
\(YEAR 10,11 AND 12)

-

n
Binnacle
Training
RTO CODE 31319
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BINNACLE PROGRAMS
FOIR SGHOOLS

SPORT, FITNESS & RECREATION PROGRAMS

SPORT & RECREATION FITNESS
Standalone and Dual Qualifications Standalone and Dual Qualifications
> SIS20115 Certificate Il in Sport and Recreation > SIS30321 Certificate lll in Fitness
(1-Year Format) + SIS20115 Certificate Il in Sport and Recreation

> §IS20321 Certificate Il in Sport Coaching (2-Year Format)

(1-Year Format) > 8SIS30321 Certificate lll in Fitness

> SIS30115 Certificate lll in Sport and Recreation (2-Year Format)

(2-Year Format)

> SIS30115 Certificate lll in Sport and Recreation
+ SIS20115 Certificate Il in Sport and Recreation
(2-Year Format)

SHORT COURSES FIRST AID & CPR

1 & 2-Term Options Flexible Delivery Options

> Introduction to Sport, Fitness and Recreation

(4-Unit Short Course | 2-Term Format)

> HLTAIDO11 Provide First Aid

> Introduction To Sport
(2-Unit Short Course | 1-Term Format) > HLTAIDO0O09 Provide cardiopulmonary

resuscitation

> Introduction To Fitness

(2-Unit Short Course | 1-Term Format)

( VISIT PROGRAMS FOR SCHOOLS [% )

The information contained in this 2024 Subject Selection Course Guide is accurate at the time of publishing.
Visit the Binnacle Website for latest Binnacle Course Offerings.
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Si1S20115 CERTIFICATE 1I
IN SPORT AND RECREATION

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

Students participate in the delivery of a range of sport and
recreation activities and programs within the school.

Graduates will be competent in a range of essential skills
including; officiating games or competitions, coaching
beginner participants to develop fundamental skills, effective
communication skills, providing quality service to participants,
and assisting with activity programs.

This program also includes the following:

> The nationally recognised First Aid competency - HLTAIDO11
Provide First Aid

> Community Coaching - Essential Skills Course (non-accredited),
issued by Australian Sports Commission

> A range of career pathway options including club level official
and/or coach, or pathway into SIS30115 Certificate Ill in Sport
and Recreation (or SIS30321 Certificate Ill in Fitness)

A Language, Literacy and Numeracy (LLN) Screening
process is undertaken at the time of initial enrolment (or
earlier) to ensure students have the capacity to effectively
engage with the content and to identify support
measures as required.

UNITS OF COMPETENCY

Delivery Format:

1-Year Format

*Packaged as a 4-Term Format however can be
delivered over 2-Years

Timetable Requirements:
1-Timetabled Line

Units of Competency:
13 (8 Core Units, 5 Elective Units)

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:

Combination of classroom and project-based
learning, online learning (self-study) and practical
work-related experience

Cost (Fee-For-Service):
$265.00 per person
(+ $55.00 First Aid)

QCE Outcome:
Maximum 4 QCE Credits

CODE TITLE

HLTAIDO11 Provide First Aid

HLTWHS001 Participate in workplace health and safety

SISXEMRO0O01 Respond to emergency situations

SISXINDOO1 Work effectively in sport, fitness and recreation environments
SISXCAI002 Assist with activity sessions

SISXINDOO2 Maintain sport, fithess and recreation industry knowledge
SISXCCS001 Provide quality service

BSBWOR202 Organise and complete daily work activities

BSBTEC201 Use business software applications
BSBTEC202 Use digital technologies to communicate in a work environment
BSBTEC203 Research using the internet
ICTICT203 Operate application software packages
BSBSUS201 Participate in environmentally sustainable work practices
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COURSE SCHEDULE
SIS20115 CERTIFICATE Il IN SPORT AND RECREATION

> Binnacle Lounge Induction
> Introduction to Coaching Programs
> Introduction to the Sport, Fitness and Recreation (SFR) Industry

PROGRAMS

> Coaching Program (Student Delivery): Plan and Deliver Coaching Sessions
> SFR Coaching Program (Supervisor): Assist with Delivering Coaching Sessions

> Perform Research and Create a Group Presentation
> Organise and Complete Work Tasks

PROGRAMS

> Group Nutrition Presentation: Create and Deliver a Presentation to your Peers
> Community SFR Program #1: Plan and Conduct Community SFR Sessions for Participants

Cardio and Conditioning Programs
> Anatomy and Physiology
> The SFR Industry

PROGRAMS

> One-on-One Cardio Program
> Group Conditioning Sessions for Adolescent Participants
> Respond to an Emergency Situation: Fire Evacuation Drill

TOPICS

> Anatomy and Physiology
> First Aid Course: HLTAIDO11 Provide First Aid

PROGRAMS

> Coaching Program (Teacher Facilitated): Assist with Delivering Coaching Sessions
> Community SFR Program #2: Plan and Conduct Community SFR Sessions for Participants

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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Si1S20321 CERTIFICATE 1l
IN SPORT COACHING

Registered Training Organisation: Binnacle Training (RTO 31319)
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COURSE OVERVIEW & OUTLINE

This qualification provides a pathway to work in assistant
coaching roles working or volunteering at community-based
sports clubs and organisations in the Australian sport industry.

Individuals with this qualification use a range of basic coaching
skills to engage participants in a specific sport. They work under
the supervision of a coach.

This program also includes the following:

> The nationally recognised First Aid competency - HLTAIDO11
Provide First Aid

> Community Coaching - Essential Skills Course (non-accredited),
issued by Australian Sports Commission

> Arange of career pathway options including club level official
and/or club assistant coach, or pathway into SIS30115
Certificate Il in Sport and Recreation or SIS30321 Certificate IlI
in Fitness

A Language, Literacy and Numeracy (LLN) Screening
process is undertaken at the time of initial enrolment (or
earlier) to ensure students have the capacity to effectively
engage with the content and to identify support
measures as required.

UNITS OF COMPETENCY

Delivery Format:
1-Year Format
(Packaged as 3-Terms)

Timetable Requirements:
1-Timetabled Line

Units of Competency:
7 (3 Core Units, 4 Elective Units)

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:

Combination of classroom and project-based
learning, online learning (self-study) and practical
work-related experience

Cost (Fee-For-Service):
$265.00 per person
(+ $55.00 First Aid)

QCE Outcome:
Maximum 4 QCE Credits

CODE TITLE

HLTAIDO11 Provide First Aid
SIRXWHSO001 Work safely

SISSSCO002 Work in a community coaching role

SISSSCO001 Conduct sport coaching sessions with foundation level participants
BSBPEF302 Develop self-awareness
BSBTWK201 Work effectively with others
SISXEMRO001 Respond to emergency situations
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COURSE SCHEDULE
SIS20321 CERTIFICATE Il IN SPORT COACHING

» Sport Specific Coaching Program
> Self-awareness

PROGRAMS

> Coaching Program: Development Program

>~ Community Coaching Programs
> Working Effectively with Others
> Work in a Community Coaching Role

PROGRAMS

> Community Coaching Program #1
> AIS Community Coaching Essential Skills (Online Course)

> Respond to Emergencies
> Work Safely
> Provide First Aid

PROGRAMS

> Community Coaching Program #2
> First Aid Course: HLTAIDO11 Provide First Aid

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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DUAL QUALIFICATION: SIS30321 CERTIFICATE Iil IN FITNESS +
S1S20115 CERTIFICATE Il IN SPORT AND RECREATION
(OR AS STANDALONE QUALIFICATION: SIS30321 CERTIFICATE Ill IN FITNESS)

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE Delivery Format:

2-Year Format

This qualification provides a pathway to work as a Fitness Instructor
in settings such as fitness facilities, gyms, and leisure and community
centres. Students gain the entry-level skills required of a Fitness
Professional (Group Exercise Instructor or Gym Fitness Instructor).

Timetable Requirements:
1-Timetabled Line
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. . . o . Units of Competency:
Students deliver programs within their school community including: Standalone Qualification -15 Units

> Community fitness programs Dual Qualification - Additional 8 Units

> Strength and conditioning for athletes and teams Suitable Year Level(s):

> 1-on-1 and group fitness sessions with male adults, female adults Year 11 and 12
and older adult clients

. . . Study Mode:
Th | ludes the foll :

IS program also |nc.u esl € _° owing Combination of classroom and project-based learning,

> The nationally recognised First Aid competency - HLTAIDO11 online learning (self-study) and practical work-related

Provide First Aid experience

> Community Coaching - Essential Skills Course (non-accredited),
issued by Australian Sports Commission Cost (Fee-For-Service):
$365.00 per person
(Cert Il entry qualification
=$265.00 + Cert lll Gap Fee = $100.00)

> A range of career pathway options including pathway into SIS40221
Certificate IV in Fitness at another provider

(+ $55.00 First Aid)
A Language, Literacy and Numeracy (LLN) Screening _ QCE Outcom_e:
process is undertaken at the time of initial enrolment (or Maximum 8 QCE Credits

earlier) to ensure students have the capacity to effectively
engage with the content and to identify support
measures as required.

UNITS OF COMPETENCY

UNITS OF COMPETENCY ADDITIONAL 8 UNITS OF COMPETENCY (OPTIONAL)
Certificate Ill in Fitness Part of the optional Certificate Il in Sport and Recreation

HLTAIDO11 Provide First Aid SISXCAI002 Assist with activity sessions
HLTWHS001 Participate in workplace health and safety SISXCCS001 Provide quality service
SISXEMRO001 ituati i i
Respond to emergency situations BSBWOR202 gégsir;ilzse and complete daily work
SISXINDOO1 Work effectively in sport, fitness and recreation
environments BSBTEC201 Use business software applications
SISXIND0O2 Maintain sport, fitness and recreation industry BSBTEC202 Use digitgl tec_hnologies to .
knowledge communicate in a work environment
BSBSUS211 Participate in sustainable work practices BSBTEC203 Research using the internet
SISEEIT047 Use anatomy a_nd physi(_:logy knowledge to support ICTICT203 Operate application software
safe and effective exercise packages
BSBOPS304 Deliver and monitor a service to customers Participate in environmentally
BSBSUS201 : )
sustainable work practices
BSBPEF301 Organise personal work priorities
SISFFIT035 Plan group exercise sessions
SISFFIT036 Instruct group exercise sessions
SISFFIT032 Complete pre-exercise screening and service
orientation
SISFFIT033 Complete client fitness assessments
SISFFIT052 Provide healthy eating information
SISFFIT040 De\{elo_p and ingtruct gym-based exercise programs
for individual clients
| Page 40 Binnacle Training Course Guide 2024
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COURSE SCHEDULE
DUAL QUALIFICATION: SIS30321 CERTIFICATE Il IN FITNESS + SIS20115 GERTIFICATE 1l IN SPORT AND RECREATION
(OR AS STANDALONE QUALIFICATION: SIS30321 CERTIFICATE Il IN FITNESS)

> The Sport, Fitness & Recreation (SFR) Industry
> Apply Knowledge of Coaching Practices

PROGRAMS

> Coaching Program (Student Delivery): Plan and Deliver Coaching Sessions
> SFR Coaching Program (Supervisor): Assist with Delivering Coaching Sessions

> Perform Research and Create a Group Presentation
> Organise and Complete Work Tasks

PROGRAMS

> Group Nutrition Presentation: Create and Deliver a Presentation to your Peers
> Community SFR Program #1: Plan and Conduct Community SFR Sessions for Participants

> Cardio and Conditioning Programs
> Anatomy and Physiology
> The SFR Industry

PROGRAMS

> One-on-One Cardio Program
> Group Conditioning Sessions for Adolescent Participants

TOPICS

> Anatomy and Physiology
> First Aid Course: HLTAIDO11 Provide First Aid

PROGRAMS

> Bootcamp Program (Teacher Facilitated): Assist with Delivering Bootcamp Sessions

QUALIFICATION SCHEDULED FOR FINALISATION

SI1S20115 CERTIFICATE Il IN SPORT AND RECREATION

> Anatomy and Physiology
> Health and Nutrition Consultations

PROGRAMS

> One-on-One Gym Program: Adolescent Client
> Conduct Consultations with a Client (Peer)
> Plan and Conduct Sessions (Scenario Clients)

TOPICS

> Screening and Health Assessments
> Specific Population Clients
> Older Clients

PROGRAMS

> Fitness Orientation Program: Client Orientation
> Gentle Exercise Program: Participate in Gentle Exercise Sessions
> Mobility Program: Plan and Instruct Mobility Sessions

> Older Clients
> Specific Populations

PROGRAMS

> Group Exercise and Gym-based One-on-One Sessions:
> Female and Male Adults aged 18+; and
> Older adults aged 55+

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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DUAL QUALIFICATION: SIS30115 CERTIFICATE Il IN SPORT AND
RECREATION + SI1S20115 CERTIFICATE Il IN SPORT AND RECREATION

(OR AS STANDALONE QUALIFICATION: SIS30115 CERTIFICATE Ill IN SPORT AND RECREATION)

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

This qualification reflects the multi-skilled role of individuals in operational
and customer support positions in the sport or community recreation
industry. Students assist with facilitation of sport and recreation programs
within their school community including:

> Officiating games

> Conducting coaching sessions

> Community sport, fitness and recreation programs
> Using digital technologies in sports environments

Available with a ‘General’ or ‘Sport Specialty’ Coaching and Officiating
outcome - AFL, NRL, Netball, Rugby Union or Choose Your Own Sport!

This program also includes the following:

> The nationally recognised First Aid competency - HLTAIDO11 Provide
First Aid

> Community Coaching - Essential Skills Course (non-accredited) and
Community Officiating General Principles Course (non-accredited), issued
by Australian Sports Commission

> A range of career pathway options including Club Level Official and/or
Coach

A Language, Literacy and Numeracy (LLN) Screening process is
undertaken at the time of initial enrolment (or earlier) to ensure
students have the capacity to effectively engage with the content
and to identify support measures as required.

UNITS OF COMPETENCY

Delivery Format:
2-Year Format

Timetable Requirements:
1-Timetabled Line

Units of Competency:

Standalone Qualification -15 Units
(Plus Term 7 Add-On: 4 Units)

Dual Qualification - Additional 6 Units

Suitable Year Level(s):
Year 11 and 12

Study Mode:

Combination of classroom and project-based
learning, online learning (self-study) and practical
work-related experience

Cost (Fee-For-Service):

$335.00 per person

(Cert Il entry qualification

= $265.00 + Cert Il Gap Fee = $70.00)
(+ $55.00 First Aid)

QCE Outcome:

Maximum 7 QCE Credits

Completion of the Term 7 Add-on as well can result
in a maximum 8 QCE Credits

UNITS OF COMPETENCY ADDITIONAL 6 UNITS OF COMPETENCY (OPTIONAL)
Certificate Il in Sport and Recreation Part of the optional Certificate Il in Sport and Recreation

HLTAIDO11 Provide First Aid

HLTWHSO001 Participate in workplace health and safety

SISXEMRO001 Respond to emergency situations

SISXINDOOA Work effectively in sport, fithess and recreation
environments

SISXCAI002 Assist with activity sessions

SISXINDOO2 Maintain sport, fitness and recreation industry
knowledge

SISXCCS001 Provide quality service

BSBWOR204  Use business technology

BSBWHS303 Participate in WH$ hazard identification, risk
assessment and risk control

SISXCAI003 Condugt non-ln.structlonal sport, fitness or
recreation sessions

ICTWEB201 Use social media tools for collaboration and
engagement

SISXCAI006 Facilitate groups

BSBWOR301 Organise personal work priorities and
development

BSBADM307  Organise schedules

SISXCAI004 Plan and conduct programs

TERM 7 ADD-ON: UNITS OF COMPETENCY

Conduct sport coaching sessions with foundation

SISSSCo00T level participants
BSBPEF302 Develop self-awareness
BSBTWK201 Work effectively with others
Provide cardiopulmonary resuscitation
HLTAIDO09 (Completed as part of Provide First Aid -
HLTAIDO11 Certificate)
I Page42

BSBWOR202  Organise and complete daily work activities

BSBTEC201 Use business software applications

BSBTEC202 Use dlgltgl technologies to communicate in a
work environment

BSBTEC203 Research using the internet

ICTICT203 Operate application software packages

BSBSUS201 Participate in environmentally sustainable work

practices
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COURSE SCHEDULE

DUAL QUALIFICATION: SIS30115 CERTIFICATE Il IN SPORT AND RECREATION +

S1S20115 CERTIFICATE Il IN SPORT AND RECREATION

(OR AS STANDALONE QUALIFICATION: SIS30115 CERTIFICATE Il IN SPORT AND RECREATION)

> Introduction to Training Programs
> Introduction to the Sport, Fitness and Recreation (SFR) Industry

> Coaching Program (Student Delivery): Plan and Deliver Coaching Sessions
> SFR Coaching Program (Supervisor): Assist with Delivering Coaching Sessions

> Perform Research and Create a Group Presentation
> Organise and Complete Work Tasks

PROGRAMS

> Group Nutrition Presentation: Create and Deliver a Presentation to your Peers
> Community SFR Program #1: Plan and Conduct Community SFR Sessions for Participants

> Cardio and Conditioning Programs
> Anatomy and Physiology
> The SFR Industry

PROGRAMS

> One-on-One Cardio Program
> Group Conditioning Sessions for Adolescent Participants
> Respond to an Emergency Situation: Fire Evacuation Drill

TOPICS

> Anatomy and Physiology
> Provide First Aid

PROGRAMS

> Coaching Program (Teacher Facilitated): Assist with Delivering Coaching Sessions
> Sports Program: Plan and Conduct Sport Sessions for Participants

QUALIFICATION SCHEDULED FOR FINALISATION

SI1S20115 CERTIFICATE Il IN SPORT AND RECREATION

> Plan and Conduct Sports Programs
> Apply Knowledge of Officiating Practices

PROGRAMS

> Group Sports Program (Teacher Facilitated)
> Use and Maintain Business Technology (Additional Project)
> Community Officiating General Principles (Online Course)

TOPICS

> Plan and Deliver a Sports Competition
> Community SFR Program

> Community SFR Program #2: Plan and Conduct Community SFR Sessions for Participants
> Round Robin Tournament
> Online Course/ Online Learning (Online Courses)

TOPICS

> Sport-Specific Coaching Sessions
TERM 7 > Personal Development
ADD ON > Workplace Performance

(OIFNRIYAS

> Sport-Specific Coaching Program

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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INTRODUCTION TO
(4-UNIT SHORT COURSE)

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

This 4-Unit Short Course is a great Year 10 option for HPE or Sports
Academy Programs prior to commencing Certificate Ill course.
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Topics of study include sport coaching, personal development, self-
awareness, healthy eating and fitness programs.

A Language, Literacy and Numeracy (LLN) Screening process is
undertaken at the time of initial enrolment (or earlier) to ensure
students have the capacity to effectively engage with the content
and to identify support measures as required.

COURSE SCHEDULE

TOPICS

> Introduction to Sport and Recreation

SPORT, FITNESS & RECREATION

Delivery Format:
2-Term Format

Timetable Requirements:
1-Timetabled Line

Units of Competency:
4 Units

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:

Combination of classroom and project-

based learning, online learning (self-
study) and practical work-related
experience

Cost (Fee-For-Service):
$80.00 per person

QCE Outcome:
Maximum 2 QCE Credits

Important Note: 4-Units of Competency
towards SIS30321 Certificate Il in Fitness

TOPICS

Introduction to Fitness

> Conducting Sport Coaching Sessions
> Personal Development and Self-Awareness

> Plan and Deliver Sport-Specific Sessions
> Create a Self-Awareness Action Plan

> Nutrition and Energy Systems
> Anatomy
> Fitness Programs

PROGRAMS

> Community Fitness Program — Plan and
Instruct Sessions for Peers
> Create a Workplace Wellbeing Action Plan

TERM 1

UNITS OF COMPETENCY

SISSSCO001 Conduc_t sport coacr_nr)g sessions with BSBTWK201
foundation level participants BSBPEF201
BSBPEF302 Develop self-awareness

INTRODUCTION TO SPORT
(2-UNIT SHORT COURSE) OR

INTRODUCTION TO FITNESS
(2-UNIT SHORT COURSE)

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

These 1-Term Short Courses are the perfect fit for schools which are
looking for a 1-Term option in their Year 10 HPE or Sports Academy
Programs.

Introduction to Sport and Recreation (2-Unit Short Course) topics include:
> Sport Coaching and Self-Awareness.

Introduction to Fitness (2-Unit Short Course) topics include:
> Fitness Programs and Body Systems.

UNITS OF COMPETENCY

Work effectively with others
Support personal wellbeing in the workplace

Delivery Format:
1-Term Format

Timetable Requirements:
1-Timetabled Line

Units of Competency:
2 Units

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:

Combination of classroom and project-
based learning, online learning (self-
study) and practical work-related
experience

Cost (Fee-For-Service):
$55.00 per person

QCE Outcome:
0 QCE Credits

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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FIRST AID &
CPR COURSES

Registered Training Organisation:
Binnacle Training (RTO 31319)

Students learn to confidently manage emergency situations and
provide first aid care to a casualty.

Qualifications offered by Binnacle Training that require HLTAIDO11
Provide First Aid:

> SIS20115 Certificate Il in Sport and Recreation
> SIS30115 Certificate lll in Sport and Recreation
> SIS20321 Certificate Il in Sport Coaching

> SIS30321 Certificate Ill in Fitness

First Aid and CPR may also be delivered as a standalone short course
- a Nationally recognised Statement of Attainment will be awarded.

Participants are required to undertake practical training and
assessment at floor level which includes demonstrating CPR on a
manikin for at least two minutes.

Participants must attend 100% of this first aid training and will also
require suitable language, literacy and numeracy skills to complete
the course.

HLTAIDO11
PROVIDE FIRST AID

Delivery Format:
Flexible Delivery Options

Timetable Requirements:

> School Term Delivery:
12 x 70 min lessons

> Two-Day Delivery:
10 hours (2 x 5-hour days)

> One-Day Delivery (Practical Only):
The practical may be completed in
approximately 5 hours

IMPORTANT: All knowledge assessments
must be completed by participants prior to
this one-day delivery.

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:
Online and Practical Performance

Cost (Fee-For-Service):
$55.00 per person

QCE Outcome:
0 QCE Credits

UNITS OF COMPETENCY

HLTAIDO11 Provide First Aid
HLTAIDO10 Provide basic emergency life support
HLTAID0O09 Provide cardiopulmonary resuscitation

HLTAIDO09
PROVIDE CARDIOPULMONARY RESUSCITATION

Delivery Format:
Flexible Delivery Options

Timetable Requirements:

> School Term Delivery:
5 x 70 min lessons

> One-Day Delivery:
Approximately 5 hours

> Half-Day Delivery (Practical Only):
The practical may be completed in
approximately 3 hours

IMPORTANT: All knowledge assessments
must be completed by participants prior to
this half-day delivery.

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:
Online and Practical Performance

Cost (Fee-For-Service):
$40.00 per person

QCE Outcome:
0 QCE Credits

UNITS OF COMPETENCY

HLTAID0O09 Provide cardiopulmonary resuscitation

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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BUSINESS & TOURISM PROGRAMS

BINNACLE PROGRAMS
FOIR SGHOOLS

BUSINESS & TOURISM PROGRAMS

BUSINESS TOURISM

Standalone Qualifications Standalone and Dual Qualifications

> SIT20122 Certificate Il in Tourism

> BSB20120 Certificate Il in Workplace Skills
(1-Year Format)

(1-Year Format)
> BSB30120 Certificate Il in Business + SIT20122
Certificate Il in Tourism
(2-Year Format)

> BSB30120 Certificate lll in Business
(2-Year Format)

SHORT COURSES

1-Term Options

> Inclusivity and Communication in the
Workplace
(8-Unit Short Course | 1-Term Format)

> Technology in the Workplace
(2-Unit Short Course | 1-Term Format)

> FNSFLT311 Develop and Apply Knowledge of
Personal Finances
(1-Term Format)

( VISIT PROGRAMS FOR SCHOOLS Q )

The information contained in this 2024 Subject Selection Course Guide is accurate at the time of publishing. Visit the
Binnacle Website for latest Binnacle Course Offerings.
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BSB20120 CERTIFICATE Ii
IN WORKPLACE SKILLS

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE Delivery Format:

1-Year Format
*Packaged as a 4-Term Format however can be

Students participate in the delivery of a range of project delivered over 2-Years

based activities and programs within their school

community. Timetable Requirements:

1-Timetabled Line

Graduates will be competent in a range of essential

business skills including; self awareness/personal Units of Competency:
effectiveness, effective communication techniques, critical 10 (5 Core units, 5 Elective units)
thinking and problem solving, time management, team
work, workplace health and safety and participating in Suitable Year Level(s):
sustainable work practices. Year 10 (or Year 11 or 12)
This program also includes: o ) Study Mode:
. . . Combination of classroom and project-based learning,
» A range of career pathway options including pathway online learning (self-study) and practical work-related
into BSB30120 Certificate Ill in Business experience

Cost (Fee-For-Service):
$225.00 per person

A Language, Literacy and Numeracy (LLN) Screening QCE Outcome:
process is undertaken at the time of initial enrolment (or Maximum 4 QCE Credits
earlier) to ensure students have the capacity to effectively

engage with the content and to identify support

measures as required.

UNITS OF COMPETENCY
e _Jme
BSBCMM211 Apply communication skills
BSBOPS201 Work effectively in business environments
BSBPEF202 Plan and apply time management
BSBSUS211 Participate in sustainable work practices
BSBWHS211 Contribute to health and safety of self and others
BSBPEF302 Develop self-awareness
BSBCRT201 Develop and apply thinking and problem solving skills
BSBTEC201 Use business software applications
BSBTEC202 Use digital technologies to communicate in a work environment
BSBTWK201 Work effectively with others
| Page 48 Binnacle Training Course Guide 2024



COURSE SCHEDULE
BSB20120 CERTIFICATE Il IN WORKPLACE SKILLS

TOPICS

> Introduction to the Business Services Industry
> Time Management
TERM 1 > Self-Awareness

PROJECTS

> Personal Effectiveness

TOPICS

> Workplace Health and Safety
> Sustainable Work Practices
> Communication Skills

PROJECTS

> Operate Safely in the Work Environment (Incident Role Play)
> WHS Audit of the Go! Travel Office Space
> Communication in the Workplace

TOPICS

> Software Applications
> Using Digital Technologies
> Working Effectively with Others

PROJECTS

> Travel Package Presentation
> Creating a Positive Work Environment - Travel Expert Team Games

TOPICS

> Critical Thinking and Problem Solving

TERM 4
PROJECTS

> Problem Solving at Go! Travel

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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SIT20122 CERTIFICATE Ii

IN TOURISM

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

Students participate in the delivery of a range of projects
and activities within their school community.

Graduates will be competent in a range of essential
Tourism and Business skills including; sourcing and
presenting information, effective communication
techniques, social and cultural sensitivity, digital
technologies and software applications, working with
others in business environments, workplace health and
safety and participating in sustainable work practices.

This program also includes the following:

> A range of career pathway options including pathway
into BSB30120 Certificate Ill in Business
> Participation in a Tourism-related Industry Discovery

A Language, Literacy and Numeracy (LLN) Screening
process is undertaken at the time of initial enrolment (or
earlier) to ensure students have the capacity to effectively

Delivery Format:
1-Year Format
(Packaged as 3-Terms)

Timetable Requirements:
1-Timetabled Line

Units of Competency:
11 (5 Core Units, 6 Elective Units)

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

Study Mode:

Combination of classroom and project-based
learning, online learning (self-study) and
practical work-related experience

Cost (Fee-For-Service):
$225.00 per person

QCE Outcome:

engage with the content and to identify support Maximum 4 QCE Credits
measures as required.
UNITS OF COMPETENCY
oo Jme
SITTINDOO3 Source and use information on the tourism and travel industry
SITXCOMO006 Source and present information
CUAEVP211 Assist with the staging of public activities or events
BSBTEC201 Use business software applications
BSBTEC203 Research using the internet
SITXWHS005 Participate in safe work practices
SITXCOMO008 Provide a briefing or scripted commentary
SITXCOMO007 Show social and cultural sensitivity
SITXCCS009 Provide customer information and assistance
SITXCCS010 Provide visitor information
SITXCCS011 Interact with customers
| Page 50 Binnacle Training Course Guide 2024



COURSE SCHEDULE
SIT20122 CERTIFICATE Il IN TOURISM

TOPICS

> Source, Use and Present Information

> Research Using the Internet
> Public Activities and Events
TERM 1 > Business Software Applications

PROJECTS

> Ecotourism and the ‘Invest in our Planet’ Event
> Tourism Business Industry Discovery
> Travel Package Presentation

> Safe Work Practices at the Go! Travel Office
> Deliver a Safety Briefing
> Social and Cultural Sensitivity

PROJECTS

> Participate in Safe Work Practices at Go! Travel
> Deliver a Safety Briefing to Go! Travel Exhibitors
> Show Social and Cultural Sensitivity in the Tourism Industry

> Provide Information to Visitors and Customers
> Interacting with Customers

PROJECTS

> Go! Travel ‘VIP’ Information Evening
> Interact with Customers at the Go! Travel Agency

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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DUAL QUALIFICATION: BSB30120
CERTIFICATE Ill IN BUSINESS +
SIT20122 CERTIFICATE 11 IN TOURISM

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

The program will be delivered through class-based tasks as
well as both simulated and real business environments at
the school - involving the delivery of a range of projects and
services within the school community.

Graduates will be competent in a range of essential business
skills including; customer service, personal and team
effectiveness, critical thinking, business technology and
documents, sourcing and presenting information, workplace
health and safety, social and cultural sensitivity and
participating in sustainable work practices.

This program also includes the following:

> Student opportunities to design for a new product or
service as part of our (non-accredited) Entrepreneurship
Project - Binnacle Boss

> Participation in a Tourism-related Industry Discovery

A Language, Literacy and Numeracy (LLN) Screening
process is undertaken at the time of initial enrolment (or
earlier) to ensure students have the capacity to effectively
engage with the content and to identify support
measures as required.

Delivery Format:
2-Year Format

Timetable Requirements:
1-Timetable Line

Units of Competency:
Dual Qualification - 22 Units

Suitable Year Level(s):
Year 11 and 12

Study Mode:

Combination of classroom and
project-based learning, online learning
(self-study) and practical work-related
experience

Cost (Fee-For-Service):

$265.00 per person (Cert Il entry
qualification = $225.00 + Cert Il Gap Fee
= $40.00)

QCE Outcome:
Maximum 10 QCE Credits

UNITS OF COMPETENCY
__CcopE J|TTLE | CODE_JTmE_ |

Source and use information on the tourism and

SITTINDOOS3 travel industry BSBPEF301 Organise personal work priorities
CUAEVP211 :jj:]S:SWith the staging of public activities or BSBPEF201 Support personal wellbeing in the workplace
SITXCOMO06  Source and present information BSBWHSS311  Assist with maintaining workplace safety
BSBTEC201 Use business software applications BSBSUS211 Participate in sustainable work practices
BSBTEC203  Research using the internet BSBTWK301  Use inclusive work practices

SITXCCS009  Provide customer information and assistance BSBXCM301  Engage in workplace communication
SITXWHS005  Participate in safe work practices BSBXTW301  Work in a team

SITXCOMO07 ~ Show social and cultural sensitivity BSBCRT311 :ﬁ\ﬁ:‘éﬁ::'eft" thinking skills in a team
SITXCCSO011 Interact with customers BSBTEC301 Design and produce business documents

SITXCCS010  Provide visitor information BSBWRT311  Write simple documents

SITXCOMO08  Provide a briefing or scripted commentary BSBOPS304  Deliver and monitor a service to customers
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COURSE SCHEDULE
BSB30120 CERTIFICATE IIl IN BUSINESS + SIT20122 CERTIFICATE Il IN TOURISM

TOPICS

> Introduction to the Business Services / Tourism and Travel Industries
> Personal Wellbeing in the Workplace
> Organise Personal Work Priorities

PROJECTS
> Wellbeing in the Workplace

TOPICS

> Source, Use and Present Information
> Research Using the Internet

> Public Activities and Events

> Business Software Applications

PROJECTS

> Ecotourism in Australia
> Tourism Industry Discovery

TOPICS

> Workplace Health and Safety
> Sustainable Work Practices

PROJECTS

> Participate in Safe Work Practices at Go! Travel
> WHS Processes at the ‘Go! Regional’ Travel Expo

TOPICS

> Providing Information to Visitors and Customers
> Interacting with Customers
> Social and Cultural Sensitivity

PROJECTS

> Go! Travel ‘VIP’ Information Evening
> Interact with Customers at the Go! Travel Agency
> Show Social and Cultural Sensitivity in the Tourism Industry

QUALIFICATION SCHEDULED FOR FINALISATION
SIT20122 CERTIFICATE Il IN TOURISM

TOPICS

> Inclusive Work Practices

> Workplace Communication
> Working in a Team
TERM 5 > Critical Thinking Skills

PROJECTS

> Inclusivity and Communication in the Workplace (Go! Travel Expo)
> Critical Thinking at Go! Travel

TOPICS
> Business Documents

PROJECTS
> Binnacle Boss (Part 1) — Business Proposal

TERM 6

TOPICS

> Deliver a Service

PROJECTS

> Binnacle Boss (Part 2) - Market Day

TERM 7

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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BSB30120 CERTIFICATE Iii
IN BUSINESS

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE Delivery Format:

2-Year Format

The program will be delivered through class-based tasks as well
as both simulated and real business environments at the school -
involving the delivery of a range of projects and services within the
school community.

Timetable Requirements:

1-Timetable Line

*Please consult Binnacle Training to

discuss Fast-Track options.
Graduates will be competent in a range of essential business skills

including; personal management and effective communication Units of Competency:
techniques, customer service, leadership and innovation, critical 13 (6 Core Units, 7 Elective Units)
thinking, business technology and documents, financial literacy,
workplace health and safety, inclusive work practices and participating Suitable Year Level(s):
in sustainable work practices. Year 11 and 12
This program also includes the following: Study Mode:
> Student opportunities to design for a new product or service as part Combination of classroom and project-
of our (non-accredited) Entrepreneurship Project - Binnacle Boss based learning, online learning
(self-study) and practical work-related
experience

A Language, Literacy and Numeracy (LLN) Screening
process is undertaken at the time of initial enrolment (or
earlier) to ensure students have the capacity to effectively
engage with the content and to identify support
measures as required.

Cost (Fee-For-Service):

$265.00 per person

Plus additional charge at the school’s
discretion: $20 Binnacle Boss Project
Start-Up Capital

QCE Outcome:
Maximum 8 QCE Credits

UNITS OF COMPETENCY
lcpE _____[TME_______________________________
BSBPEF201 Support personal wellbeing in the workplace
BSBPEF301 Organise personal work priorities
FNSFLT311 Develop and apply knowledge of personal finances
BSBWHS311 Assist with maintaining workplace safety
BSBSUS211 Participate in sustainable work practices
BSBXCM301 Engage in workplace communication
BSBTWKS301 Use inclusive work practices
BSBXTW301 Work in a team
BSBCRT311 Apply critical thinking skills in a team environment
BSBTEC301 Design and produce business documents
BSBWRT311 Write simple documents
BSBTEC303 Create electronic presentations
BSBOPS304 Deliver and monitor a service to customers
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COURSE SCHEDULE
BSB30120 CERTIFICATE IIl IN BUSINESS

TOPICS

> Introduction to the Business Services Industry
> Personal Wellbeing in the Workplace
> Organise Personal Work Priorities

PROJECTS

> Wellbeing in the Workplace

TOPICS

> Develop and Apply Knowledge of Personal Finances

PROJECTS

> Knowledge of Personal Finances

TOPICS

> Workplace Health and Safety
> Sustainable Work Practices

PROJECTS

> WHS Processes at the ‘Go! Regional’ Travel Expo

TOPICS

> Inclusive Work Practices
> Engage in Workplace Communication

PROJECTS

> Inclusivity and Communication in the Workplace

TOPICS

> Work in a Team
> Critical Thinking Skills

PROJECTS

> Critical Thinking at Go! Travel

TOPICS

> Create Electronic Presentations
> Creating Presentations Using PowerPoint
> Write Simple Documents

PROJECTS

> Binnacle Boss (Part 1) — Business Proposal

TOPICS
> Critical Thinking and Problem Solving
PROJECTS

> Binnacle Boss (Part 2) - Market Day / Entrepreneurship Expo

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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INCLUSIVITY AND COMMUNICATION
IN THE WORKPLACE
(3-UNIT SHORT COURSE)

Registered Training Organisation: Binnacle Training (RTO 31319)

=
=
©
=
o
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COURSE OVERVIEW & OUTLINE Delivery Format:
1-Term Format
This 3-Unit Short Course provides students with an opportunity
to participate in two practical projects where they will develop
skills in communication and social and cultural awareness.

Timetable Requirements:
1-Timetabled Line

This is a wonderful course for preparing senior students for Units of Competency:
customer service related employment. 3 Units

*These units of competency form part of Binnacle Training’s Dual : .
Qualification: BSB30120 Certificate lllin Business + SIT20122 f;ﬁg';:'ﬁ:;'ﬁ";'(fg)
Certificate Il in Tourism.
Study Mode:
Combination of classroom and self
directed online learning
A Language, Literacy and Numeracy (LLN) Screening

process is undertaken at the time of initial enrolment (or Cost (Fee-For-Service):
earlier) to ensure students have the capacity to effectively $70.00 per person
engage with the content and to identify support

measures as required. QCE Outcome:

Maximum 1 QCE Credit

Important Note: 3-Units of Competency
towards SIT20122 Certificate Il in Tourism

COURSE SCHEDULE

TOPICS

> Plan and Participate in Workplace Communication

> Work Effectively with Individual Differences

> Assess Use of Inclusive Practices

> Communicate with Customers and Colleagues from Diverse Backgrounds
> Address Cross-Cultural Misunderstandings

PROJECTS

> Inclusivity and Communication in the Workplace

> ‘Go! Regional’ Travel Expo Display — Plan, Deliver and Review
> Show Social and Cultural Sensitivity in the Tourism Industry

> Interact with Customers

> Handling Cross-Cultural Misunderstandings (role play)

UNITS OF COMPETENCY

BSBXCM301 Engage in workplace communication
BSBTWKS01 Use inclusive work practices
SITXCOMO007  Show social and cultural sensitivity

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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TECHNOLOGY
IN THE WORKPLACE
(2-UNIT SHORT COURSE)

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE

This 2-Unit Short Course provides students with an opportunity
to use business software applications and use digital
technologies to communicate in the workplace.

Students will plan, draft and finalise presentation designs to
present to peers. Students will collaborate in teams using an
array of digital communications. These are skills that will assist in
many areas of future work and study.

Delivery Format:
1-Term Format

Timetable Requirements:
1-Timetabled Line

Units of Competency:
2 Units

Suitable Year Level(s):

. . . Year 10 (or Year 11 or 12)
*These units of competency form part of Binnacle Training’s

BSB20120 Certificate Il in Workplace Skills. Study Mode:
Combination of classroom and self
directed online learning

A Language, Literacy and Numeracy (LLN) Screening

process is undertaken at the time of initial enrolment (or Cost (Fee-For-Service):
earlier) to ensure students have the capacity to effectively $55.00 per person
engage with the content and to identify support
measures as required. QCE Outcome:
0 QCE Credits
COURSE SCHEDULE

TOPICS

> Business Software Applications

> Select and Prepare to Use Technology

> Input and Process Information Data

> Finalise and Store Documents

> Methods of Digital Communication

> Send and Receive Digital Communications
> Managing Digital Communications

PROJECTS

> Travel Package Presentation

UNITS OF COMPETENCY

BSBTEC201 Use digital software applications

BSBTEC202 Use digital technologies to communicate in a work environment

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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FNSFLT311 DEVELOP AND
APPLY KNOWLEDGE OF
PERSONAL FINANCES

Registered Training Organisation: Binnacle Training (RTO 31319)

COURSE OVERVIEW & OUTLINE _Delivery Format:
1-Term or Flexible Delivery Options
This Short Course is all about students developing their money Timetable Requirements:

management skills. 1-Timetabled Line

Students are provided with a budget template required to

set financial goals and are prompted to input budget data in
accordance with a progressive real life scenario. This is a great
course for preparing your senior students with Financial Literacy
skills and knowledge.

Units of Competency:
1 Unit

Suitable Year Level(s):
Year 10 (or Year 11 or 12)

*This unit of competency has been included by Binnacle Training

as an ‘imported elective’ in the full qualification - BSB30120 o Study Mode:
Certificate Il in Business Combination of classroom and self directed

online learning

Cost (Fee-For-Service):

A Language, Literacy and Numeracy (LLN) Screening $55.00 per person
process is undertaken at the time of initial enrolment (or

earlier) to ensure students have the capacity to effectively QCE Outcome:
engage with the content and to identify support 0 QCE Credits

measures as required.

COURSE SCHEDULE

TOPICS

> Develop and Maintain Knowledge of Personal Finance Matters
> Manage Personal Finances

> Budgeting, Cash flow and Savings

> Taxation Matters

> Superannuation Matters

> Debt Management

> Employee Entitlements

> Insurance Matters

> Career choice, Education and Skills
Create a Personal Budget for the Future

PROJECTS

> Knowledge of Personal Finances
> Establish your Financial Goals

> Create a Budget for the Future (Part 1)
> Create a Budget for the Future (Part 2)

UNITS OF COMPETENCY

FNSFLT311 Develop and apply knowledge of personal finances

Please note this 2024 Course Schedule is current at the time of publishing and should be used as a guide only. This document is to be
read in conjunction with Binnacle Training’s Program Disclosure Statement (PDS). The PDS sets out the services and training products
Binnacle Training as RTO provides and those services carried out by the School as Third Party (i.e. the facilitation of training and
assessment services). To access Binnacle’s PDS, please visit: binnacletraining.com.au/rto
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COURSE SNAPSHOT
BROCHURIES

COURSE-SPECIFIC OVERVIEW INCLUDING CAREER PATHWAYS

SPORT AND RECREATION FITNESS
1, 2 & 3-Year Pathways 1, 2 & 3-Year Pathways
FIND OUT MORE > FIND OUT MORE >

student Learning Activity

ation

WORK HEALTH & SAF

& sport, fitness, and recre
proce 5, to ensure the safety of yourse
equipment use, the SFR industry relie

lowing this, those participating in the SFR
Ccompon

s\l

‘- L ONSad

BUSINESS TOURISM AND BUSINESS
1, 2 & 3-Year Pathways 1, 2 & 3-Year Pathways
FIND OUT MORE > FIND OUT MORE >

< VISIT SUPPORT CENTRE Q )
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FUTURE LEARNING

RARBINVAYES

EMPLOYMENT HIGHER
PATHWAYS EDUCATION

CERTIFICATE Il  CERTIFICATE Il

Tourism Small Business
Administration Owr_1er or
. Business
Business Assistant, Manager
Customer Marketi ’
Workplace Service Officer arketing
Skills Coordinator,
Accountant
Spor.ts_ . Certificate IV, Sport Program
Administration .
Officer. Club Diploma or Manager,
Sport and o University Degree Development
. Level Official . .
Recreation with another Officer,
or Coach, . .
: Education Recreation
Regional Provider Officer
Sport and Sports Officer
Recreation +
Sport
Coaching . Exercise
Fitness . .
Physiologist,
Instructor,
Strength and
Fithess Gym Conditioning
Supervisor,
. Coach,
Group Trainer .
Exercise
Specialist
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WHAT DOES BINNACLE
IAKEYSCAR ERO

> RTO Compliance
> Training and Assessment Strategy (TAS)

> Maintenance and improvements of
our Binnacle Lounge - Online Learning
Management System (LMS)

> The teachers’ and student’s learning
experience is our highest priority

> Assessment Validation
> Teacher Marking Guides
> Teacher Project Guidance

> Enable Industry and VET Professional
Development opportunities (Semester 1
Workshops and ViSC in Semester 2)

» Facilitation of Industry Workplace Visits to all
major regions across Queensland
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SEIS

Binnacle Training gives consent for partner schools to
use our 2024 Subject Selection Course Guide as a tool to
help you develop your Subject Selection Handbook and
website information.

Please utilise our program-specific information outlined

in this document and copy and paste the course-specific
information to help you create your own Subject Selection
Handbook.

Alternatively, you can also access additional
program-specific information in our Course Snapshot
Brochures which are located in the Support Centre at
binnacletraining.com.au/rto

G ONIR EVARDNG

The following FOUR Mandatory Inclusions must be
included in your School’s Subject Selection material
when promoting a Binnacle Certificate Program to
your students:

1) RTO Name and Code (Binnacle Training RTO 31319)
2) Qualification Code and Title (specific to each program)

3) Binnacle Program Disclosure Statement (PDS)
declaration

4) Language, Literacy and Numeracy (LLN) Skills
Statement

Optional inclusions:
> Binnacle Training Logo
> Units of Competency List (in each program)

“Please note that the Subject Selection Material from the previous year must not be used. You must download the
necessary Subject Selection documentation from the Binnacle Support Centre each year to ensure information being

supplied to students and parents is accurate and up-to-date.

( VISIT SUPPORT CENTRE ‘k >
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MARKETING
SQUIREMERNTS

FOR SUBJECT SELECTION - SUBMIT FOR APPROVAL

> Your School (Third Party) is required to submit your > In the event you (the school) make edits to Binnacle-
Subject Selection Material (for each Binnacle Program supplied templates that impact or change the integrity
you are set to offer), for Binnacle pre-approval. of the document [e.g. reference to the training
This is to be submitted with your signed Third Party product(s), roles and responsibilities of Binnacle and
Agreement in Term 1. the school in the delivery of the training product(s)],

>  This includes subject information as positioned in this must be submitted to Binnacle for pre-approval.

your School Handbook and/or School Website. If your
Subject Selection Material has already been finalised,
please submit a copy for approval for future use.

MARKETING REQUIREMENTS FOR SCHOOL SUBJECT SELECTION MATERIAL
(SUBJECT HANDBOOKS AND GUIDES)

REQUIREMENT EXAMPLE

RTO Full Name (Binnacle
Training) and RTO Code (31319)

This is to be listed alongside Binnacle Training RTO 31319
reference to the qualification
code and title, per above

Full qualification code and title

BSB30120 Certificate Il in Business
must be used

MANDATORY PDS Declaration:
INCLUSIONS: This document is to be read in conjunction with Binnacle Training’s

Program Disclosure Statement (PDS). The PDS sets out the services
and training products Binnacle Training as RTO provides and those
services carried out by the School as Third Party (i.e. the facilitation of
training and assessment services). To access Binnacle’s PDS, please
visit: binnacletraining.com.au/rto

Binnacle’s Program Disclosure
Statement (PDS) declaration

Language, Literacy and A Language, Literacy and Numeracy (LLN) Screening process is
Numeracy (LLN) Skills undertaken at the time of initial enrolment (or earlier) to ensure
statement. In particular, must students have the capacity to effectively engage with the content and
specify: to identify support measures as required.
Use our most recent Binnacle BlnnaCIe
Training RTO Code Logo Training

OPTIONAL RTO CODE 31319

INCLUSIO

List the units of competency in
the Training Program (located in
Support Centre)

Full Unit Code + Full Unit Name
eg. HLTWHSO001 Participate in workplace health and safety

There must be no reference made to the Vocational Education and
Training in Schools (VETIS) Initiative, funded by the QLD Government.
While Binnacle Training is a Skills Assure Supplier (SAS) with the

No reference to be made to the Queensland Government for the Certificate Il in Sport and Recreation,

VETIS initiative, funded by the due to the partner school being a “third party” in the delivery of
IMPORTANT *Queegsland Government training and assessment, this program must not be marketed
INFORMATION: Ao SEaeels CRYATT i as ‘VETiS-funded’ or ‘VETiS funding eligible’ by the third party.

SIS20115 Certificate Il in Sport

and Recreation Importantly, please ensure there is:

> NO reference to Binnacle being a Skills Assure Supplier; and

> NO reference to the Certificate Il in Sport and Recreation (or any
other qualification) as being VETIS funded with Binnacle Training.
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MARKETING
S@QUIREMENTS cowre)

FOR SCHOOL WEBSITE (COURSE OFFERINGS REFERENCING BINNACLE TRAINING)

For School websites pertaining to Vocational Education Program offerings, it is vital that the School (Third Party) provides
a clear delineation of the way their Vocational Education and Training (VET) courses are undertaken. This includes listing
the Name and RTO Code of each provider.

Vocational Education and Training (VET) courses can be undertaken in the following ways:

1) [School Name] as Registered Training Organisation (RTO #[ ).
2

) External RTO delivered at [School Name].
3) External RTO delivered at External RTO premises.
)

4) School Based Traineeship or Apprenticeship.

MARKETING REQUIREMENTS CHECKLIST - SCHOOL WEBSITES

REQUIREMENT EXAMPLE

RTO Full Name (Binnacle Training) and RTO Code (31319)

This is to be listed alongside reference to the qualification Binnacle Training RTO 31319
code and title, per above

MANDATORY
INCLUSIONS:

Full qualification code and title must be used BSB30120 Certificate lll in Business

If you feature your School’s Subject Handbook (or Guide) on
your website please make sure it is updated and features the
most current information of the course.

IMPORTANT Please reference the role of the the School, as Third Party,
. providing training and assessment services on behalf of
INFORMATION: Binnacle Training (RTO Code 31319).

If displaying your range of VET course offerings, provide a
clear delineation of the way each course is undertaken, per
above. This includes listing the RTO Code of each provider.
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SUPPORT CENTRE

Our Support Centre is a comprehensive resource library for all relevant program and
school documentation that will answer many of your questions. All documents are in
PDF format and easily downloadable directly from our website.

THE MOST COMMONLY ACCESSED
DOCUMENTATION INCLUDES:

> RTO Files

> Third Party Agreement

> Resource Requirements

> Independent Contractor

> Parent Acknowledgement

> Invoicing Procedures

> Subject Selection Information
> Course Outline - First Aid

> Forms

> Key Binnacle Procedures

> Career Expo Resources

> LLN Screening

> RTO Audit Information

> Sport-Specific Accreditation
> Student Information

> Training & Assessment Strategy (TAS)

( VISIT SUPPORT CENTRE Q >
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MAXIMISE YOUR
SCHOOL’S = || [V L/.]
AND) GaRIEE[R 22470

Our range of digital resources are designed to ‘Make Life Easier for Teachers’ in preparing
for, and getting the most out of your school’s Subject Selection processes and events.

Teachers and VET Managers can find the resources listed below in the Support Centre.

> 2024 Course Snapshot Brochures - Double-sided A4 page (for each Course offering)

> Subject Selection Slideshow Presentation (PowerPoint Versions available)
2024 Sport, Fitness and Recreation Programs
2024 Business and Tourism Programs

> Binnacle Training Logos

( VISIT SUPPORT CENTRE Q >
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Binnacle
Training

RTO CODE 31319

CONTACT US

1300 303 715
admin@binnacletraining.com.au
binnacletraining.com.au

0006

Allowing Teachers
to Teach


http:///
mailto:admin@binnacletraining.com.au 
http://binnacletraining.com.au
https://www.facebook.com/binnacleRTO/
https://www.linkedin.com/company/binnacle-training-college/mycompany/?viewAsMember=true
https://www.instagram.com/binnacletraining/?hl=en

